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Welcome to the BioCAM X platform and thank you for your purchase. The BioCAM X platform is among 
the most advanced systems for managing your experiments on the emerging generation of high-den-
sity CMOS-MEAs. This manual has been written to help you to take advantage of all functionalities 
provided by your BioCAM X. Be sure to read this manual thoroughly, and to keep it handy when using 
the BioCAM X platform.

Before any use of your BioCAM X platform, please read the “Precautions” on page 15, which contains 
relevant information to preserver your BioChips and BioCAM X from possible damages.

MEA technology
Among the different methodologies used for electrophysiological measures, metal microelectrodes in-
tegrated on-chip can provide multisite measures of extracellular signals with a high signal-to-noise ratio. 
In addition, by applying voltage or current stimuli to the same microelectrodes it is possible to depolar-
ize cells or tissues, thus establishing bi-directional interfaces. As established over several decades of 
research, both sensing and actuating performances of microelectrodes can be applied to study a wide 
range of electrogenic cells and tissues, including neuronal and cardiac preparations. 

Conventional microelectrode arrays (MEAs) are bio-sensing chips realized by means of thin-film tech-
nologies and do not integrate on-chip any microelectronic circuit. Therefore, conventional MEAs are 
passive devices made on silicon, glass or polymeric substrates. Each microelectrode can be made by 
different materials (e.g. Pt, IrOx, TiN) and it is individually wired on-chip and connected to an external 
amplifier and data acquisition (DAQ) instrument. Due to the need of this MEA technology of individually 
routing on-chip each electrode, space constraints and wiring encumbrance impede the realization of 
dense and large electrode arrays. Thus, for conventional MEAs the typical electrode pitch is in the range 
of 100 µm and the array includes from 60 up to 256 microelectrodes. In addition, given the distance 
between the electrodes and the off-chip amplifiers and the use of interconnecting wires, conventional 
MEAs are subjected to inductive coupling noise.

CMOS-MEA technology
The electrode density and array sizes can be increased by changing the technology used to realize 
microelectrode arrays (MEAs). High-density MEAs are realized with complementary metal–oxide–semi-
conductor technology (CMOS), as it is done for microelectronic devices (e.g., computer microproces-
sors) and light-imaging devices (e.g., camera sensor), and with post-processing methods to optimize the 
electrode performances.

Briefly, the CMOS technology allows to realize active electrode-pixels that integrate in small areas of a 
few square micrometers electrodes, amplifiers and signal conditioning circuits in-pixel, just underneath 
each electrode site. On-chip, additional amplification stages, multiplexing and high-speed addressing 
circuits are provided. 

In particular, the circuit architecture of 3Brain’s BioChips is based on the Active Pixel Sensor concepts, 
as commonly used for light imaging CMOS cameras, and was designed to allow full array recordings at 
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sufficiently high sampling frequency for each electrode.

In BioChips the local in-pixel buffers underneath each electrode allow to locally adapt signals from high 
impedance (electrode-side) to low impedance (wiring-side) to avoid the induction of coupling noise 
from electrical wiring before amplification. Additionally, the on-chip multiplexing and addressing circuits 
allow to minimize the number of wiring outputs even though the large number of electrodes that have 
to be simultaneously measured. Indeed, each electrode signal is not individually wired off-chip. Rather, 
signals of multiple electrodes are multiplexed at high frequency over a few number of wires. In this way, 
several thousands of electrodes can be recorded on only a few tens of output wires. 

The in-pixel circuit implemented in BioChips allows recordings from a large signal bandwidth that 
includes field potentials and spikes. Instead of implementing an AC-coupling solution that would require 
large areas for the integration of adequate capacitors, the BioChips in-pixel circuit integrates an au-
to-zeroing circuit that is regularly calibrated to the electrode DC voltage and that subtracts this cali-
brated DC voltage from the electrode signal before the first amplification stage.  This process is called 
calibration and it also allows to adapt the circuit performance to different experimental conditions. In 
particular, all CMOS devices are photosensitive and photo-generated charges give rise to different DC 
drifting times that can bring in-pixel amplifiers to saturate. BioChips mitigate these effects and hence 
allow experiments under light stimulation conditions (as required for instance for retina stimulation) by 
using higher calibration frequencies to keep the DC input signal to the working point of the amplifier and 
to avoid the saturation of the amplifier. 
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Overview
The BioCAM X platform is a high resolution electrophysiology system capable to perform in-vitro elec-
trophysiological measures on electroactive cells and tissues. Even though, to some extents, the plat-
form has some similarities with more conventional  Microelectrode Array (MEA) systems, it is a radically 
new technology to perform extracellular measures. Differently than conventional MEA systems, the 
BioCAM X platform relies on active CMOS-MEA chips, which integrate thousands of miniaturized active 
electrodes over large areas. Combined to sub-millisecond temporal resolution, the dense integration of 
electrodes results in a spatial resolution that enables novel analysis, can increase the statistical signif-
icance of your experiments and opens new imaging approaches to investigate electroactive prepara-
tions.

The 3Brain’s BioCAM X platforms was tested so far for in-vitro electrophysiological experiments on 
neuronal cell cultures, brain slices, retina preparations and cardiac cultures. Electrophysiological signals 
ranging from slow field potentials to fast single cell spiking activity can be recorded simultaneously. 
Examples of recordings provided by different laboratories using the BioCam platforms are available on 
the 3Brain website and uploads of novel examples based on your research are warmly welcome. 

Overall, the platform consists of three basic components: A) a multiuse BioChip cartridge available in 
different models and incorporating the CMOS-MEA silicon chip; B) the acquisition BioCAM X hardware 
that reads out electrophysiological signals from the BioChip; C) the host PC equipped with the acqui-
sition board and the BrainWave X software to acquire, visualize, store and analyse experimental data 
recorded with the BioCAM X platform. 
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BioChip
The BioChip cartridge integrates on an electronic substrate the CMOS-MEA chip and a reservoir cham-
ber to maintain cultures or tissues contacting the electrode array either under cell culture media or per-
fused media, respectively. The cartridge is 54 mm x 54 mm (2-1/8 in x 2-1/8 in) in size and is conceived 
to be placed in an incubator for cells or tissue cultures.

•	 Contact pads: gold-plated pads for connection between the BioChip and the BioCAM X. Properly 
cleaned and non-oxidized pads are needed for a stable connection.

•	 PCB: the printed circuit board substrate of the BioChip. Different colors are available and according to 
the layout of the CMOS-MEA.

•	 Glass ring: borosilicate glass ring defining the reservoir. External diameter 28mm (1-7/64 in), internal 
diameter 25mm (0-63/64 in), height 5mm (0-13/64 in).

•	 Reservoir: chamber for the bath solution used for the biological preparation. The volume of solution 
that can be contained is of about 2mL.

•	 CMOS-MEA: chip integrating thousands of active electrodes for high-resolution electrophysiological 
recordings from cells or tissues placed on its active area. Different application-specific MEA layouts 
according to the BioChip model are available. 

Contact pads

Glass ring

PCB

Reservoir

CMOS-MEA
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BioCAM X
The BioCAM X is the station where BioChips are plugged into for electrophysiological measures. This 
instrument is compatible with all BioChip types including also those with electrical stimulation capabili-
ties. It contains all the electronics, real-time hardware and logic to control the CMOS-MEAs chips on the 
BioChip cartridges and to acquire and pre-process large-volume of electrophysiological data before 
sending it to the host PC.

Magnetic plate

Lock button

Peltier-Element
BioChip bay

•	 Lock button: two-position button for locking (end position) or unlocking (mid position) the BioChips.

•	 BioChip bay: bay for inserting the BioChip and connecting it to the BioCAM X.

•	 Magnetic plate: ferromagnetic stainless steel to attach magnetic holders (e.g., for perfusion).

•	 Peltier-Element: active element to control the temperature of your preparation on BioChips
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Power button Camera Link USB BCExt connector Power port

•	 Camera-link: SDR mini Camera Link connector to connect the BioCAM X to the acquisition board 
mounted in the host PC. Electrophysiological data and control signals are managed through this 
interface. 

•	 USB: this port is used only for firmware updates of the BioCAM X. For normal use it is not needed to 
connect this interface.

•	 BCExt connector: plug the BCExtAdapter cable to access extended functionalities such us triggering 
and stimulation. 

•	 Power port: plug for the power supply unit.

BioChip slot Bay Barrier & BioChip connector Reference connector LED1 LED2

•	 BioChip slot: the slot through which the BioChip (contact pads side) is inserted into the BioCAM X for 
electrical interfacing. 

•	 Bay Barrier & BioChip connector: immediately behind the BioChip slot, a protective movable Bay Bar-
rier blocks accidental overflows of liquids that might get in touch and damage the internal electronics. 
Behind the Bay Barrier, the BioChip connector allows to connect the BioChip’s contact pads to the 
internal circuitry. Electrical contacts are established only once the locking system is activated.

•	 Reference connector: connector for the pseudo-reference electrode that need to be placed in the 
bath solution of the BioChip cartridges.

•	 LED1: a solid blue LED indicates whether the BioCAM X is powered (LED ON) or not (LED OFF). A sol-
id violet LED indicates a failure in BioCAM firmware. In addition, the LED1 blinks violet to indicate that 
the temperature control is ON.

•	 LED2: a solid green LED indicates whether the BioCAM X is acquiring signal (LED ON) or is in stand-by 
mode (LED OFF). 

•	 Power button: push-button to power ON or OFF off the BioCAM X (the instrument need to be con-
nected to a power line using the provided adaptor).
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Host PC
Depending on your order the host PC can be a desktop PC or a laptop. The way the BioCAM X instru-
ment is connected to the host PC changes according to these two cases.

Desktop PC
When connected to a desktop workstation, the connection is direct between the BioCAM X and the 
host PC that is equipped with a Camera Link acquisition board. The typical configuration is as follow 
(tower desktop not shown).

BioCAM X  with 
BioChip

Desktop host PC 
with BrainWave X

Laptop PC
When connected to a laptop PC, you need an adapter to connect the BioCAM X to the host PC. Such 
adapter is a Thunderbolt-Camera Link adapter box that encloses the Camera Link acquisition board. 
The typical configuration for a laptop hosting PC is illustrated here below.

BioCAM X  with 
BioChip

Laptop host PC 
with BrainWave X

Thunderbolt-
Camera Link adapter
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BrainWave X
BrainWave X is a complete software application developed to exploit all the functionalities of your 
BioCAM X platform. It is equipped with advanced tools adapted to manage high-resolution electro-
physiological data acquired from BioChips. When launched it appears as follows (without experiments 
ongoing).

•	 Main Menu: access main functions by clicking on the main menu.

•	 Tool Bar: displays tools provided by the data controls currently shown in the Workspace. Tools are 
refreshed according to the currently focused controls and for some controls can be missing. 

•	 Panels: dockable panels that are automatically updated according to the currently selected experi-
ment loaded into the Workspace. Panels allow you to modify the experiment’s options and parame-
ters and can be shown or hidden by choosing the Window menu on the Main Menu.

•	 Left Status Bar: notifies you about ongoing operations.

•	 Workspace: arena for visualizing through tabs online and offline experiments.

•	 Right Status Bar: notifies you about the status of the controlled devices. It comprises also LED icons 
for BioCAM and BioChip devices. If the LED icon is on (blue) the corresponding device is properly 
connected and recognized.

Main Menu

Tool Bar

Panels

Workspace

Left Status Bar Right Status Bar
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BioCAM X handling and use 
The BioCAM X instrument is made with a solid metal case and with optimized electronics that make 
the system robust to mechanical and vibrational noise. Even if it is recommended, the installation on an 
anti-vibration table is not mandatory. 

Moreover, the instrument has been design to be shielded from external electrical environmental noise. 
However, to guarantee optimal recording performances simple precautions as listed here below should 
be followed:

•	 Position the BioCAM X far from potential strong noise sources, such as fridges, incubators etc… In-
deed, if not well shielded these instruments might generate electromagnetic noise.

•	 Connect the BioCAM X to adequate power lines with low noise levels.

•	 Take care to avoid that electrical cables connected to the BioCAM X (in particular, the one for the 
power supply and for the Camera Link) do not pass near other power supplies.

•	 Check that the cable connectors are well inserted into the BioCAM X and the Host PC before operat-
ing the platform.

The system allows for the integration of a perfusion system as it is needed for maintaining tissues 
during electrophysiological measures. Even if precautions have been taken in designing the system to 
prevent liquids to enter in contact with the internal electronics, spill out of electrophysiological solution 
that might get into the BioChip slot should be strictly avoided. However, should this happen please 
follow these steps:

1.	 Immediately switch OFF the BioCAM and remove the BioChip. 

2.	 Clean accurately the BioChip Bay of the BioCAM X with ethanol 96% and let it dry. Execute the same 
procedure for all the BioChip parts but for the BioChip reservoir and in particular for the BioChip con-
nector pads. 

3.	 In case after the cleaning with ethanol, there are still doubts that some liquid could have been 
penetrated into the BioCAM X, do not switch on the system for at least one day, allowing the liquid 
to be completed dried and preserving internal circuitry from potential oxidative and short-circuit 
effects. 

Some precautions have to be also taken when manipulating the pseudo-reference, which from one 
side (connector) is connected to the BioCAM X and whose other end (platinum wire) needs to be placed 
into the bath solution inside the BioChips:

•	 Handle the reference with care by wearing gloves and avoid touching the platinum wire (i.e. the part 
of the reference that is in contact with the electrophysiological solution). 

•	 Clean regularly the reference to guarantee optimal recording performances. The platinum wire 
of the reference should be rinsed with deionized water before starting and after an experimental 
session. Alternatively, for a heavier cleaning, the platinum wire only can be immersed in HCl 0.1M for 
about 1 minute and then abundantly rinsed with deionized water.

•	 When the BioChip is inserted and the reference is positioned in the electrophysiological solu-
tion, the operation of switching ON or OFF the BioCAM X might cause electrical glitches that can 
potentially damage the circuitry of the CMOS-MEA chip. To avoid this, it is a good practice to follow 
the operational sequence of plugging the BioChip, switching ON the BioCAM X and then insert the 
reference into the liquid. In an analogous way, remove the reference from the electrophysiological 
solution before switching OFF the BioCAM X and unplug the BioChip. 
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BioChip handling and use 
BioChips are low-power active electronic circuits and it is highly recommended to avoid the following 
operations that might result in a damaging of their electronics:

•	 Do not touch the contact pads of the BioChip. Electrostatic charges might damage the on-chip 
circuits and might result in damaging the device. Always manipulate the BioChip by holding it on the 
sides and ideally by using plastic gloves. 

•	 Do not hold the BioChip by its glass ring to avoid detaching it. 

•	 Do not touch the active area of the BioChips with any tools except those specifically allowed (see 
“Cleaning procedure for BioChips”). In particular, hard or semi-hard objects (e.g. metal or plastic tools) 
can irreparably damage the electrodes and the on-chip circuits.

•	 For cleaning or for sterilization avoid immersing the entire BioChip in water or ethanol. Prolonged 
immersion in water of the entire BioChip might cause oxidation of the contact pads. In ethanol, some 
parts of the BioChip might be deteriorated. As a general rule only the chamber can be wet while the 
rest of the chip should stay dry. 

•	 Do not place the BioChips in autoclaves, ovens or under UV-light exposure for sterilization. These 
methods might deteriorate the CMOS devices, resulting in malfunctioning or in reduced lifetime. For 
the BioChip sterilization, please refer to the “Sterilization procedure for BioChips”.  

•	 Maintain the pH of the electrophysiological solutions used for neuronal cultures or brain tissues pos-
sibly at physiological conditions (7-7.5). Important changes in the pH of the solution might damage the 
electrodes.

During recordings (both cultures and brain tissues) users have to comply with the following precautions: 

•	 Before contacting the BioChip into the BioCam, clean the metal pad contacts with a tissue paper 
soaked with ethanol 96% and let it dry for few seconds.

•	 Avoid liquids to spill out and strictly avoid liquids to enter in contact with the pads (the BioCAM sys-
tem is equipped with a Bay Barrier to protect the connecting socket). In case users experience liquid 
spill out, follows instructions provided in the “BioCAM X handling and use” section.

In order to ensure a good quality of the recordings:

•	 Avoid using HEPES (4-(2-hydroxyethyl)-1-piperazineethanesulfonic acid) in the solutions used for 
electrophysiological recordings, since we observed that it can interfere with the electrodes making 
the chip unstable and the recordings very noisy.

•	 BioChips are light-sensitive devices and their performances might be affected by a too high intensity 
direct exposure or by noisy light sources. 
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Cleaning procedure for BioChips
Normal cleaning
It is a good practice to clean the BioChips immediately after the experimental recordings both for cell 
cultures as well as brain tissues. First, rinse abundantly the BioChips with Double Deionized Water 
(DDW), then fill the chambers with a detergent as WPI-Enzol (WPI) or Terg-A-zyme (Alconox) and gently 
pipette for few seconds. Leave the detergent for few minutes (typically 3-5 min) and then pipette again. 

After the use of detergent, rinse the BioChips abundantly with DDW, then leave the chamber filled with 
DDW for 1-2 minutes and repeat this operation 3-4 times in order to assure to wash out completely the 
detergent. 

Intense cleaning
In case the chips are very dirty, users can mechanically remove cellular debris with a soft brush. Be 
aware that this operation can damage the sensing area of the chip, so it is suggested only if, after a 
normal cleaning procedure, the chips still present dirtiness and in any case it has to be performed very 
mildly and carefully. 

Finishing and storage
Biochips can be dried by using a gentle flux of Nitrogen air (do not directly expose the recording area to 
the flux to avoid potential electrode damages). Alternatively let the BioChips dry on a bench by covering 
them with a plastic petri dish to avoid dust deposition on the recording area. 

The Biochips area out of the chamber can be cleaned with a tissue soaked in ethanol 96%. It’ a good 
practice to manipulate chips always wearing gloves.

Once the BioChips are dried they should be stored in a closed box in order to protect them from dust 
and dirtiness.

As a general rule, avoid sterilizing or using ethanol in the BioChip chamber without having preventively 
cleaned the chip from cellular debris of previous experiments. Alcohol can fix biological materials on the 
recording area of the chips, resulting in a degeneration of the signal recording performances. 
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Sterilization procedure for BioChips
As indicated in the previous section, BioChips cannot be put in autoclaves, ovens or under UV-light 
exposure for sterilization purpose. These procedures risk to deteriorate the chips resulting in not optimal 
recording performances and in a shorter lifetime. 

If still not done, perform a cleaning procedure as indicated in the “Cleaning procedure for BioChips” 
previous section and adopt the following procedure (that has to be performed under a biological hood) 
to sterilize the chips: 

1.	 Clean the area of the BioChips outside the glass ring (including the external part of the glass ring 
itself) by using a tissue soaked with ethanol 96% and put inside sterile plastic petri dishes. 

2.	 Fill the reservoir completely with ethanol 70%. Also dip with the same solution the border of the glass 
ring (the tiny upward-oriented side of the ring). Hence, wait for 20 minutes. 

3.	 Suck the ethanol with a pipette or with a vacuum pump always using sterile tips. 

4.	Fill 3/4 of the reservoir of the BioChips with sterile DDW, wait few seconds and suck the liquid always 
with sterile tips. Repeat these operations 4 times to ensure to wash out completely the ethanol. When 
removing sterile DDW for the last time, be sure to have completely dried the chamber. Aspirate the 
liquid on the recording area always by keeping the tip close to the glue/CMOS border but not touch-
ing the CMOS to avoid any risk to damage the electrodes. 
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Install the BioCAM X 
Follow the below instruction to install the BioCAM X platform when you receive a pre-configured host 
PC from 3Brain. Instructions differs according to which type of hosting PC you have ordered. If you have 
not purchased a pre-configured host PC, please refer to section “Set up a non pre-configured host PC” 
before proceeding with the following instructions.

Desktop host PC  
1.	 Plug the power supply cable into the power port located in the back of BioCAM X and then connect 

the power supply into an electrical outlet. Switch ON the BioCAM X by pressing the power button on 
the back. The BioCAM’s LED1 should turn ON.

2.	Turn on the PC, plug one end of the Camera Link cable into the acquisition board located in the back 
side of the PC and the other end of the Camera Link cable into the Camera Link port of the BioCAM 
X. Tighten the screws in the connectors on both sides to secure the Camera Link cable.

3.	 Launch BrainWave X software and verify that the BioCAM X is properly recognized by checking that 
the BioCAM LED icon in the BrainWave’s Right Status Bar turns ON.

Laptop host PC 
1.	 Plug the power supply cable into the power port located in the back of BioCAM X and then connect 

the power supply into an electrical outlet. Switch ON the BioCAM X by pressing the power button on 
the back. The BioCAM’s LED1 should turn ON.

2.	 Plug the power supply cable into the power port located in the back of the Thunderbolt-Camera Link 
adapter box.

3.	 Connect one end of the Camera Link cable into the Thunderbolt-Camera Link adapter and the other 
end of the Camera Link cable into the Camera Link port of the BioCAM X. Tighten the screws in the 
connectors on both sides to secure the Camera Link cable.

4.	 Connect one end of the Thunderbolt cable into the Thunderbolt-Camera Link adapter and the other 
end into one free port in the laptop host PC.

5.	Turn on the laptop PC. Please consider that according to the version of Windows and the drivers 
installed in your machine, Windows might not recognize the Thunderbolt-Camera Link adapter if this 
is connected after Windows is already running. Hence, in this case make sure to turn on the PC only 
once everything is properly connected as explained above. For such versions of Windows, if the con-
nection with the BioCAM X is lost, a Windows restart might be required.

6.	Launch BrainWave X software and verify that the BioCAM X is properly recognized by checking that 
the BioCAM LED icon in the BrainWave’s Device Status Bar turns ON.
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Plug the BioChip
BioChips are connected to the BioCAM X through the lock system, which is operated by a two-position 
button. When the button is pressed till its mid position the BioChip is released or the locking system is 
opened to allow to plug a BioChip into the BioCAM X. When the button is pressed till its end position the 
BioChip is locked and connected to the BioCAM X.

To plug the BioChip into the BioCAM X:

1.	 Insert the BioChip into the BioCAM X sliding it along the BioChip bay. The BioChip should enter into 
the BioCAM’s BioChip slot till the distance between the BioChip end and the BioCAM X end is approx-
imately 7mm (1/4 in). If the BioChip does not enter till the ending position, try to push the BioCAM X’s 
lock button till its mid position to release the locking system and then try re-inserting the BioChip.

2.	 Push the Lock button in the BioCAM X to its end position to lock the BioChip to the BioCAM X con-
nector. On BrainWave X software the BioChip LED icon in the Device Status Bar should turn ON.

Rest position Mid position (release) End position (lock)

3.	 To start using the BioChip, plug the electrode reference into the BioCAM X and place the platinum 
end of the electrode inside the BioChip’s reservoir, which must be filled in with a physiological saline 
solution (or a simple saline solution when performing system testings).

BioChip insertion

~7mm (1/4 inch)

reference electrode 
connector
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To unplug the BioChip:

1.	 Press the BioCAM X’s lock button down to its mid position till you hear a pop.

2.	Slide out the BioChip by holding it aside its glass ring (pushing with two fingers on the BioChip PCB), 
hence avoiding any shear stress on the glass ring.

Set up a non pre-configured host PC
If your order included a pre-configured host PC you can skip this step. If you are going to configure your 
own PC, please follow this instructions before installing the BioCAM X.

1.	 Install the acquisition board driver by launching the installer and following the instructions. The ac-
quisition board driver are provided to you by the customer support. If you have not received those, 
please contact customer support.

2.	 Get the latest version of BrainWave X by downloading it from http://www.3brain.com/downloads. 
Once downloaded, double-click on the installer and follow the instructions. 

3.	Start BrainWave X. A message requiring to update BrainWave X might be displayed.  We strongly rec-
ommend to accept in order to keep your software running at its best. After the installation of updates, 
the software automatically restarts. Verify that in the BrainWave X’s Right Status Bar there are no error 
message. If you see a message like “No detected acquisition board” it means that either the acqui-
sition board is not installed properly in the PC or its driver are not installed. In the latest case, repeat 
step 1.

4.	 Follow the instruction in “Install the BioCAM X” to verify that all the components are properly installed.

Verify proper functioning
Once you have installed and turned on the BioCAM X, opened and updated BrainWave X on the host 
PC and positioned a BioChip together with the reference electrode (see above sections), you can easily 
verify the proper functioning of the system by the following check list:

1.	 Verify that both BioCAM LED and Biochip LED icons in the BrainWave’s Right Status Bar are ON (see 
section “BrainWave X” on page 14).

2.	 On BrainWave go to File > Open Recorder. On the new opening window click on the Play button to 
start an acquisition and then select a few channels to open their graphs (see “Visualize live data” on 
page 29)and verify that data is acquired from the BioChip (if you have not placed a living sample on it, 
you should visualize noise traces in the range of +/- 100 µVolt)

If anything of the above went wrong, please contact the customer support.

http://www.3brain.com/downloads.html
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Basic concepts

Visualization of data
BrainWave X makes use of tools designed to manage high resolution data coming from CMOS-MEAs. 
This has been implemented by combining conventional approaches with innovative ones. In particular, 
since BioChips act as “cameras for extracellular electrophysiological potentials”, several functionalities 
were introduced following similar approaches as used in multimedia.

BrainWave X is an all-in-one software including tools for recording, visualizing, analyzing and exporting 
your data. Use of BrainWave X differs based on whether you are visualizing live data from your biological 
preparation or whether you are playing back data previously recorded. These two different scenario are 
referred as online mode and offline mode respectively.

The term Experiment can be used both for an online and an offline experiment. When a new Experi-
ment is started (online) or open (offline), its data is loaded and displayed in the BrainWave X’s Workspace 
area. More Experiments can be loaded during a single application session, in particular you can manage 
at the same time multiple offline Experiments and one single online Experiment. When multiple Experi-
ments are open, they are organized in tabbed documents. When passing from an Experiment to anoth-
er by clicking on its corresponding tab, BrainWave X updates all the panels with the Experiment’s data.

Panels Experiment

Tabs
click on a tab to 
select a different 
Experiment
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MEA Viewer control
Electrodes integrated in the CMOS-MEA are referred in BrainWave as Channels (abbreviated Ch). A 
fundamental control to browse your data is the MEA Viewer

Settings
affecting the way the channels’ volt-
age values are converted to colors

Color scale
for current settings

MEA Viewer
representation of the voltage 
values of the channels by a 
color map

Hover and click
to select channels. Move 
from top to down and from 
left to right to increase 
channel’s row and column 
coordinates respectively.
Hold Shift while clicking or 
drag an area to select multi-
ple channels.

MEA Viewer displays the activity at the current time position by a false-color map. The map gives a 
representation of the activity by converting the channels’ voltage values in your MEA to pixel colors. This 
is done according to the below color scale and settings. At a specific time location in your recorded Ex-
periment the MEA Viewer gives an image representation of the activity. When instead you visualize live 
data acquired from the BioChip or when you playback recorded Experiments, the MEA Viewer refreshes 
continuously thus creating an activity movie. 

Each square pixel in the MEA Viewer represents a channel in your MEA. Channels are identified by their 
row and column coordinates. By convention row coordinate comes first than column coordinate, hence 
for instance the channel [10, 5] is the channel at row 10 and column 5.

MEA Viewer allows you to select single or multiple channels. To select multiple channels you can either 
hold down Shift on your keyboard while clicking on channels or click and drag an area over the MEA 
Viewer.
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Data formats
BrainWave X works with two main file types although it can export data in other formats. Those two own 
file types are BRW- and BXR-files. Both file types are using HDF5 hierarchical data format (hdfgroup.
org). You can easily open them within most operating systems (including Windows, Linux and Mac OS) 
and most used data analysis environments, such as, among others, Python, Matlab, Scilab, Octave and 
R. You can find detailed documentation on both data files on 3brain.com/downloads#documentation.

BRW stands for Brainwave RaW data file and contains continuous or qua-
si-continuous data streamed from the BioCAM. BRW files, according to your 
acquisition settings, can contain for instance raw data recorded from all the 
BioChip MEA channels or a temporal subset of those data. In what follows 
you will learn to record plain raw data file.

BXR stands for Brainwave eXperiment Result data file and contains discrete 
data obtained by analyzing and processing the raw data. BXR files can for 
instance contain the timestamps of the detected spikes. In the following 
section you will learn to create a BXR-file starting from a BRW-file.

Conceptually, a BXR-file is created starting from a BRW-file, hence a BXR-file is associated and linked 
to its parent BRW-file (while it is not true that a BRW-file is linked to a BXR-file). BXR-file can be deleted 
and recreated starting from the BRW-file, while if a BRW-file is deleted the contained data is lost for-
ever. However, since BRW-file are typically large files containing a huge amount of information, some-
times you might find useful to delete the BRW-file once the relevant results have been obtained and 
saved in a BXR-file.

http://www.hdfgroup.org
http://www.hdfgroup.org
http://www.3brain.com/downloads.html#documentation
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File > Open Recorder

Right-click on Workspace > 
Open Recorder

Online mode (Record mode)

Important notes
Before performing any recording it is worth to take note of how your PC is configured in order to store 
your data properly. If you have received a pre-configured host PC you need to identify proper drives 
to store data. These drives are either single high-performance drives (e.g., high-end HDD or SSD) or 
multiple drives (typically two) in striping configuration (also called RAID0). To locate these drives under 
Windows Explorer search for drives named RAID0 or LiveRec, respectively. When recording, you should 
always select these drives to avoid data loss. However, if you select a drive that is not fast enough and 
data loss is occurring you will be notified by BrainWave. 

In case of a RAID0 configuration, bear in mind that this unit is backed by two physical hard disks that 
the OS operate in parallel to enhance speed. A RAID0 configuration should not be confused with the 
mirroring (RAID1) configuration that allows to copy your data on two physical hard disks thus protecting 
your data from loss due to hard disk failure. RAID0 configuration does not help protecting your data: a 
failure of any of the two underlying hard disks will cause a data loss. Hence you should always backup 
your important data. For details on RAID configurations check https://en.wikipedia.org/wiki/Standard_
RAID_levels.

Before moving forward, follow all the steps detailed in “Install the BioCAM X” and “Plug the BioChip”. 
Hence, make sure that the BioCAM and the BioChip are properly connected by checking that the corre-
sponding LED icons in the BrainWave X’s Right Status Bar are turned ON (blue icon).

Open recorder
Open the recorder by either 

•	 Choosing File > Open Recorder, or 

•	 Right-clicking on the Workspace > Open Recorder, or 

•	 Pressing Ctrl+N

A new online Experiment opens as a tabbed document. Only one online Experiment can be open 
during an application session and it can be identified by the  icon and the “Recorder” text on the 
document tab.

https://en.wikipedia.org/wiki/Standard_RAID_levels
https://en.wikipedia.org/wiki/Standard_RAID_levels
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Recorder tab

1. Click Play
to start an acquisition.

MEA Viewer starts to display data coming from the BioChip 
by converting MEA channels’ voltage values into a colored 
movie.

Selected channels are 
visualized in individual 
charts.

2. Select channels
by clicking on the MEA 
Viewer. To select more 
channels hold Shift.

3. Chart panel
to adjust charts 
scale by dragging 
bars for time window 
width and for ampli-
tude range.

Visualize live data
To start an acquisition and visualizing data read out from the BioChip:

1.	 Click Play under the Commands panel to start the acquisition. The MEA Viewer starts refreshing and 
displaying data. 

2.	 Click on the MEA Viewer to select individual channels or Shift-click to select more channels. For each 
selected channel a new chart is plotted on the right showing the voltage data being read out from 
that channel. 

3.	 Use the Chart panel to adjust channels’ charts. Two controls are available on the Chart panel for 
both the time (X) and amplitude (Y) axis scale values of the charts. The time control regulates the 
time window used by the charts. By selecting a given time window width (e.g., 500ms) the charts are 
refreshed by periods of the same time duration. The amplitude control allows to select the Minimum 
and Maximum values visible on the charts in the Y axis.

To stop the acquisition simply click on the Stop button under the Commands panel.
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BioChip Calibration
In case you experience several electrodes with short or prolonged periods of time where no signal is 
visible, you may suffer signal saturation problems. In this case, follow these steps before proceeding on 
with recording data.

A typical example of a chip with saturating behavior is illustrated in the image below. On the left, the 
MEA Viewer shows many deep blue colored pixels indicating not working channels while on the right 
typical raw data traces with short periods of saturation (top-left, top-right and bottom-left) or even with 
persistent saturation (bottom-right) are shown.

This behavior might be related to a wrong setting of the working point of the amplifiers that are integrat-
ed underneath the electrodes. In such case, follow the instructions below for a correct BioChip calibra-
tion; if the problem persists you can refer to the section “Electrodes with no-signal (saturation)”.

BrainWave features two functions to perform BioChip calibration: an automatic and a manual procedure. 
The automatic calibration button is positioned in the Commands panel. To perform an automatic calibra-
tion you first need to start an acquisition (by clicking on the Play button) and then to click on the BioChip 
Calibration button. The procedure will take from few tens of seconds up to roughly a minute, depending 
on the BioChip conditions.

If automatic calibration is not satisfactory you can perform a manual calibration. To access this feature 
you need the Chip Calibration panel (if not opened,  go to BrainWave menu: Window > Recorder > Chip 
Calibration). From the panel you can move the sliding bar to set a value for the amplifier bias that mini-
mizes the saturation of the electrodes. Normally, value in the range of 0 to -100 allows to achieve good 
performances, but values out of this range might be needed too. Moving the bar toward higher nega-
tive values will eliminate saturation from those electrodes that oscillate between working condition to 
saturation (i.e. blinking deep blue pixels in the MEA Viewer control). If you set a too high negative value, 
some electrodes will start saturating permanently (i.e. fixed deep blue pixels in the MEA Viewer control). 
For a correct setting start from values close to 0 and move the bar by small steps towards the left until 
an optimal condition is found.

Automatic Chip Calibration Manual Chip Calibration
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6. Click Record
to start recording.

A bar indicates the progress of 
the recording

7. Wait for the set 
time or click Stop to 
finish recording.

4. Click browse 
button

to choose the recording 
destination path.

5. Choose the 
Length

of the experiment to 
record.

Record live data
Complete the steps to “Visualize live data” and then:

4.	 Click the browse button on the Info panel to choose the path where to save your data. Be aware that 
to safely record from high resolution MEA you need high performance hard disks. Hence, browse to 
a file located either on a high-end disk (e.g., SSD; solid-state drive) or on a disk pool configured with 
RAID 0 (striping). If your order included a pre-configured host PC, the disk partition where you should 
record your file is typically labeled with LiveRec or RAID0. Once you chose the path, by default Brain-
Wave X selects for you the file name, but you can modify this by typing in the Name field.

5.	Choose the length of the experiment you want to record by bearing in mind that the experiment will 
last this duration or shorter but not longer.

6.	Click the Record button in the Commands panel to start recording. In the Progress panel you can see 
the elapsed and remaining time of the recording.

7.	Wait until the set experiment length or click the Stop button at any time to finish recording. The re-
corded file is a BRW-file located at the position you selected in step 4.

http://en.wikipedia.org/wiki/Solid-state_drive
http://en.wikipedia.org/wiki/RAID
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Offline mode (Playback mode)
The tutorial contained in this section is based on the demo file on dissociated neuronal cultures you can 
find on http://www.3brain.com/downloads. Download that file and then extract it to a known location by 
using 7-Zip or WinRAR.

Open recorded data
Locate the demo BRW-file to open. Then to open it in BrainWave X do one of the following:

•	 Choose File > Open, or 

•	 right-click on the Workspace > Open, or 

•	 press Ctrl+O, or 

•	 drag the file from Windows Explorer into BrainWave X, or 

•	 double-click on the file in Windows Explorer.

A new offline Experiment opens as a tabbed document. The tab name is the name of the BXR-file as-
sociated to the BRW-file. Since you have open a BRW-file and no BXR-file has still been created the tab 
name will be in the form “Untitled-X”, being X a progressive application session-wide number. Hence, if 
this is the first file you open in this session it will be named “Untitled-1”.

The offline Experiment tab and the panels are similar to the online case, however some controls and 
functions change.

Offline Experiment tab 
with no results saved so far.

Timeline panel
to browse to specific 
time positions.

Info panel
reports the path to the 
BRW-file (if existing and 

properly linked) and to 
the BXR-file (if already 

saved).

Vertical tabs
to access Experi-

ment-specific further 
data and statistics.
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Quick analysis and save of results
As a first step, we perform a spike detection on the loaded data. Choose Analysis > Peak Detection 
from the Main Menu or alternatively press Ctrl+P. On the new opening window, simply leave the default 
parameters and click OK and then wait for the analysis to be accomplished.

Once finished, the BXR-field in the Info panel turns yellow to indicate that there are unsaved data. To 
save data do one of the following:

•	 Click on the icon right to the BXR field in the Info panel;

•	 Click File > Save

•	 Press Ctrl+S

Once you have saved the data, the Experiment tab name indicates the BXR-file name and the BXR field 
in the Info panel updates too.
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Visualize recorded data
As a consequence of the analysis, notice that the Timeline bar is now filled with vertical lines whose col-
ors indicate the degree of the overall detected activity (averaged on the entire MEA) along the temporal 
axis. A blue-color indicates a relatively low activity, while a red-color a relatively high activity around that 
time position.

To browse your Experiment for signals:

1.	 Click the MEA Viewer on channel [24, 9] to open its chart

2.	Click the Timeline bar in correspondence of the first red vertical line (near 0.5s). You will see the 
activity around the selected time position for the entire MEA in the MEA Viewer and the data for the 
channel [24, 9] in its chart.

Timeline bar 
is filled with vertical 
colored lines indicating 
the level of activity.

Chart bars
indicating detected 
spikes

Play button 

Speed control

Timeline cursor
a red overlaying  rect-
angle with central, left 
and right markers

2. Click Timeline bar 
in corrispondence of the 
red line (near 0.5s).

1. Click MEA Viewer 
on channel [24, 9] to 
open its chart.

The timeline cursor centers at that 
position. MEA Viewer and chart 
refresh accordingly.

Try to move to other spatial positions in the MEA by selecting other channels in the MEA Viewer (in 
particular red channels) and to other time positions by clicking or dragging on the Timeline bar. To move 
along the time axis, you can also click Play (Stop) in order to automatically playback (stop) the data 
stream or alternatively you can use the Left and Right Arrow keys on the keyboard. When Play is on or 
you use the arrow keys, the speed at which data is refreshed is given by the Speed control under the 
Timeline panel. Speed can also be adjusted with the Up and Down Arrow keys.
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Charts Time bin =
Timeline cursor width =
Charts width

MEA Viewer Bin setting =
bin to integrate for colors = 
Charts’ overlay rectangle width

Understanding main controls affecting graphs
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Create a group of relevant channels
You can create groups of channels according to your selection or a given statistical information. Here 
we create a group considering channels’ global mea firing rate (MFR) values. Global MFR is computed 
for each MEA channel as the number of detected spikes divided by the length of the recording (spk/s). 
To create a group of most relevant and active channels:

1.	 Click on the MFR tab under your Experiment document.

2.	 Click on the arrow aside the Global MFR panel to expand the panel. The new enlarged panel contains 
a colored map representing the activity on the entire MEA as global MFR. For each channel the global 
MFR value is converted into a color according to the below color scale.

3.	Set the Range definition left and right values to 0.200 and 4.000 spk/s respectively. In this way, we 
consider only those channels whose global MFR ranges between such values. The number of in-
range channels should be 1135 with such settings.

4.	 Click on the button to create a new channel group and then in the new opening window click OK.

1. Click on MFR tab

3. Set  Range values
to 0.200 and 4.000 spk/s.

4. Click
to create a channels 
group made up by 
in-range channels.

2. Click on Global MFR 
Stats arrow

to expand the panel

Stats should indicate 1135 in-range 
channels.
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1. Right-click on Chan-
nel Selection 

then choose Select Channels 
Group > NewGroup

2.  Click on Instantaneous MFR panel 
to activate the MFR chart  (Charts panel con-
trols update to this chart). 

3.  Zoom charts
either by using Chart panel controls or by dragging 
an area on the chart.

Instantaneous MFR chart 
is plotted by summing all 

the selected channels and 
binning according to the Bin 

size setting.

Visualize Instantaneous MFR
In addition to the Global MFR it might be useful to observe the instantaneous MFR, which gives the 
trend of the MFR computing it on successive small temporal bins. To plot the Time MFR:

1.	 Right-click on Channel Selection panel then choose Select Channels Group > NewGroup to select all 
the channels belonging to the newly created channels group. An instantaneous MFR chart is plotted 
by summing up together all the selected channels and binning according to the Bin size setting in the 
Chart panel.

To zoom the MFR chart:

2.	 Click on the Instantaneous MFR panel to activate the MFR chart. In this way the Charts panel updates 
to show the controls corresponding to this chart.

3.	 Zoom the MFR chart either by using Chart panel controls or by dragging an area of interest on the 
chart. If you have dragged an area on the chart, you can un-zoom with right-click on the chart and 
choosing Un-Zoom.
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1. Click on Raster tab

2. Increase Bar width
for the raster to 2pt in order 

to have a more defined 
raster.

3. Zoom on time axis
by using the Timeline bar control and moving the 
aside handlers.

A time raster chart is plotted.

Visualize Raster
The time raster is another common tool used to observe activity on your data.
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Troubleshooting

6
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Electrodes with no-signal (saturation)
Symptoms
Few electrodes in the array have either persistent or short periods with no visible signal. This effect is 
overall called saturation and in this section we will refer to its two possible subtypes: persistent satura-
tion (i.e. a channel is always saturated and no signal is displayed) and jumping saturation (i.e. raw signal is 
affected by short periods of saturation typically of tens to hundreds of milliseconds). 

In the MEA Viewer control (left image) in BrainWave saturating electrodes show a lowest fixed color 
scale value (persistent saturation) or they blink toward the lowest scale value. The lowest color scale 
value is typically deep blue but may differ according to the chosen color scale. By displaying the raw 
traces of the single electrodes it is possible to see either “jumping” signals disappearing for short pe-
riods of time (right image: top-left, top-right and bottom-left traces) or no signals (right image: bot-
tom-right trace).

Causes
Saturation arises (i) when the input signal amplitude exceeds the operational range of the amplifiers 
integrated inside the BioChip’s CMOS or (ii) when the amplifiers working range is not properly set. In the 
first case, this could be due to invalid signal input, for instance; in the second case a wrong calibration of 
the BioChip could be the cause. 

Possible scenarios and remedies

# Scenario Remedy

 S1 Electrodes on the BioChip are insulated by 
tiny bubbles that form when adding a saline 
solution because of the hydrophobicity of the 
CMOS surface. Insulated electrodes exhibit 
persistent saturation because the input signal 
is missing.

This scenario arises only when trying a new 
BioChip or a BioChip that has not been used 
for a long period. A 2x or 4x magnification 
lenses are enough to observe these bubbles.

Use a plastic pipette with a small tip to flow 
liquid on the CMOS surface in order to remove 
the bubbles. While doing so, be very careful 
not to touch the CMOS and to avoid electrodes 
damages.
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# Scenario Remedy

S2 CMOS is exposed to  too high an environ-
mental light source and it is not properly 
configured to work in such conditions. In such 
scenario several electrodes typically exhibit 
jumping saturation.

Turn off the light source or cover the BioChip 
with a cap (as those that can be provided to-
gether with the BioCAM X system). 

If you cannot perform this operations, or if you 
need light on the BioChip (e.g. for light stimu-
lation purposes) configure BrainWave to make 
the BioChip working in such conditions.

If the problem is not solved, check following 
scenarios and remedies.

S3 Pseudo-reference electrode is dirty or it has 
not been cleaned for a relatively long period. 
Proteins and impurities can attach with time 
to the reference electrode and degrade the 
reference performances, causing few or many 
channels to exhibit persistent saturation.

Check section “BioCAM X handling and use” 
how to clean the pseudo-reference electrode.

S4 BioChip is not properly calibrated. In such sce-
nario some channels might show persistent 
saturation while others suffer from jumping 
saturation.

Check section “BioChip Calibration” to calibrate 
the chip.

S5 BioChip is either damaged or worn out. If no one of the above remedies worked you 
may need to change the BioChip.



42

BioChip not properly initialized
Symptoms
On the MEA Viewer control in BrainWave, large red horizontal stripes move up or down across the entire 
array.

Causes
BioChip are monolithic CMOS-MEA chips integrating active semiconductor components (i.e. transistors)
underneath and around the active area (i.e. the area exposing the sensing surface of the electrodes). 
Some of these active components need to be correctly biased by sending configuration settings from 
BrainWave to the BioCam and the BioChip before starting the read out of the data. This operation is 
performed when starting the acquisition in BrainWave (e.g.by clicking Play or Record buttons). If the con-
nection to the BioChip is not in place or it is compromised, the initialization of the chip will fail.

Possible scenarios and remedies

# Scenario Remedy

 S6 BioCAM locking system (see section “Plug 
the BioChip”) was in the unlocked state when 
acquisition was initiated.

Stop the acquisition, make sure that the Bio-
Chip is properly inserted till the end of its bay 
and push the Lock button of the BioCAM X to 
its end position (see section “Plug the BioChip” 
for more details). Make sure that the BioChip 
LED icon on the BrainWave’s Right Status Bar 
(see section “BrainWave X”) is on, signalling that 
the BioChip is properly inserted and locked. 
Restart the acquisition.

If the BioChip LED icon on BrainWave does not 
turn on, see following scenarios.
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# Scenario Remedy

S7 BioChip contact pad is dirty or damaged. Extract the BioChip from the BioCAM and clean 
all the gold contact pads on the BioChip by 
using a tissue soaked with pure ethanol (>96%). 

In case you observe some dirt on the pads you 
can also try to remove it by using a soft rubbe.
Be careful not to damage or remove the gold 
layer covering the electrical contacts. Then, 
clean again with pure ethanol and let it dry for 
at least one minute. 

If cleaning has no effect, try one or more differ-
ent BioChips to verify the problem does not lie 
in the BioCAM. If also other BioChips exhibit the 
same problem, go to next scenario.

S8 BioCAM X bridge module, which is responsi-
ble to connect the BioChip to the BioCAM, is 
dirty or damaged.

Take one BioCAM Contact Cleaner and follow 
these instructions to try to clean the BioCAM X 
bridge module:

1.	 Soak the cleaner on the marked area with 
pure ethanol (>96%)

2.	 Unlock the BioCAM locking system

3.	 Insert the cleaner, making sure it is inserted 
till the very end of the BioChip bay

4.	 Lock the BioCAM locking system

5.	Slowly and carefully remove the cleaner 
moving it in parallel to the BioCAM main axis 
(zigzagging can damage the contact springs)  
while the locking system is locked down.

6.	Repeat points 2 to 5 three times or until the 
BioCAM X bridge module is clean

If cleaning has no effect, please contact cus-
tomer support.
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Not working columns
Symptoms
Groups of 4 columns do not work. This typically happens on 4 columns but might also involve 8 or 12 
columns and in any case a multiple of 4 columns (columns are grouped by 4 in the multiplexing logic). 
If you see only part of a column or a single column in a non-working conditions, then the BioChip is in-
herently damaged at that location. In most cases it is still possible to record from the remaining working 
electrodes.

Causes
One or more of the lines that go from the BioChip to the BioCAM X exhibit a faulty connection. This issue 
typically occurs between the BioChip contact pad(s) and the BioCAM X bridge module integrated inside 
the mechanical locking system. 

Possible scenarios and remedies
Check scenarios “S7” and “S8” in previous sections.
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BioChip with dirty surface
Symptoms
This scenario can occur when testing a BioChip with no biological preparation. The chip might not have 
been properly cleaned or has not been used for a long period. In this situation, several electrodes on 
the array could exhibit either higher level of noise or signals with fake peaks. In Brainwave, you typically 
see several spots (single electrodes) with red values on the overall array (left image) . Single electrode 
raw traces can have either high noise levels (centre image: bottom traces are more noisy than average 
traces on top) or peaks at a sustained pace (right image). Most of the peaks have a shape quite different 
from that of a real spike, but some might still look similar.

Causes
BioChip CMOS surface is dirty, which makes some electrodes unstable.

Possible scenarios and remedies

# Scenario Remedy

 S9 BioChip electrodes are dirty of debris and/or 
more likely of dust particles.

While the chip is connected and is filled with 
saline solution, start acquiring and visualizing 
incoming data with BrainWave to have a feed-
back on whether the problem is solved. 

As a first step, try pipetting with a small plastic 
pipette by placing the tip roughly at 45° and 
very close to the CMOS central area. Be very 
careful not to touch the CMOS with the tip.

If this does not help, you can also try to use 
a soft brush directly on the CMOS surface by 
gently brushing repeatedly until all the instable 
electrodes get recovered.


